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Abstract

This document is a printable version of the Interaction Recorder Extreme
Query help. Interaction Recorder Extreme Query Client is a component of
the Interaction Recorder add-on module for IC Business Manager. Using
Extreme Query, you can search for recorded calls, view and sort Search
Results, view Graph Data of search results, playback and score recorded
calls, and Export search results to a file.
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About Interaction Recorder Extreme Query
Interaction Recorder Extreme Query is an ultra-fast solution for running searches and retrieving stored call recordings for playback
and scoring. The Extreme Query Server can store information about millions of call recordings for quick retrieval. The Extreme
Query Client is used to conduct extremely fast searches against the Extreme Query Server, and playback and score recorded phone
calls.

Interaction Recorder Extreme Query Client is a component of the Interaction Recorder add-on module for IC Business Manager.
Using Extreme Query, you can search for recorded calls, view and sort Search Results, view Graph Data of search results, playback
and score recorded calls, and Export search results to a file.

Related Topics

Extreme Query Client User Interface

Review Interaction Recorder Extreme Query Resources
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Extreme Query Client User Interface
Extreme Query Client uses the IC Business Manager user interface, which makes it easy to navigate when creating searches and
playing back recordings. The interface includes a Workspace to create a search and display Search Results. For basic information
on using the IC Business Manager interface, see Getting Started on the Help menu.

To learn more about the Extreme Query client user interface features, pause the mouse pointer over areas in the graphic below, and
click to display more information.

 

Related Topics

About Interaction Recorder Extreme Query

Review Interaction Recorder Extreme Query Resources
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Review Interaction Recorder Extreme Query Resources
Because Interaction Recorder Extreme Query is integrated with Customer Interaction Center, there are additional technical
references, user guides, and online Helps that include Interaction Recorder information. Documents are available in the
PureConnect Documentation Library on your CIC server.

The latest versions of these documents can also be accessed from the PureConnect Documentation Library on the PureConnect
website at: 
http://help.genesys.com

For Interaction Recorder Extreme Query related information, see the following technical references, Helps, and links:
Interaction Recorder Extreme Query Installation and Configuration Guide
Interaction Recorder Technical Reference
Interaction Administrator Help
IC Business Manager Help
Interaction Recorder Client for IC Business Manager Help

Related Topics

About Interaction Recorder Extreme Query

Extreme Query Client User Interface
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Extreme Query Searches
The Interaction Recorder Extreme Query view, for searching recordings, is displayed in the Workspace. Searches are easily created
in the Workspace by selecting pre-defined and custom search attributes. After running a Search, results are displayed in a list of
recorded call interactions in the Search Results pane in the Workspace.

 

 

Creating an Extreme Query Search
Create an Extreme Query search to quickly retrieve and playback a recorded call. In the Extreme Query view, select Attributes or an
ID to run a search. The Search Results are displayed in the Workspace.

To begin a search, open the Extreme Query page in the Workspace. From the Interaction Recorder Extreme Query Navigation Pane,
click Search for recordings.

The Extreme Query View is displayed in the Workspace.

Creating a Search
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Creating a Search using Attributes

Search criteria must contain a Date attribute or a Time attribute, or both. Date and Time are configured separately. When a Date and
Time are both configured, the Time attribute is the time of day a recording might have occurred for each date included in the search.
For example, if the Date is specified as Last Month and the Time is specified between 9:00:00 AM and 5:00:00 PM, the search
results include recordings that occurred between 9 AM and 5 PM on every day of the previous month. If a Date is not specified, the
search results include all of the recordings in the database for the configured Time.

Follow these steps to create a search using Attributes.
1. In the Search by area, select Attributes.
2. Under Date, in the drop-down list, select the Date attribute. Date options are: Date range, Today, Yesterday, Last Week, Last

Month, or No date. If you select Date range, from the next list select an option Before, After, or Between. Depending on your
choice, in the Date boxes type or select a date from the drop-down calendar.

3. Under Time of Day, in the drop-down list, select the Time attribute. Time options are: No Time, After, Before, Between.
Depending on your choice, in the Time boxes type or select the part of the time you want to change.

4. Add additional attributes to your search using the Add Attribute list. Available attributes are: Agent, Duration, Phone number,
and Queue. You will be required to configure additional values based on your attribute choices. For more information, see
Additional Attributes. To delete an attribute from a search, click the attribute button and on the menu, click Remove. To remove
All Attributes from the search, right-click in the area of the Additional Attributes box, and select Clear All Attributes on the
shortcut menu. 

Note  Up to five additional custom attributes can be defined for the Add Attribute list. Define custom attributes in Interaction
Recorder Policy Editor in Interaction Administrator. For more information, see Defining_Custom_Attributes.

5. When search attributes are complete, click Search.

The results are displayed in the Search Results pane.
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Creating a Search using an ID

There are two options for searching with an ID. You can search by Recording ID or by Interaction ID.

Follow these steps to create a search using an ID.
1. In the Search by area, select ID.
2. In the box to the right, select either Recording ID or Interaction ID.

3. In the ID box, type a valid ID string.
4. Click Search. The recording is displayed in the Search Results pane.

 

When you run a search, the Search Results pane is displayed in the Workspace. If you want to view the details of the search, click
Show search details.

The Search details pane is displayed at the top of the Workspace.

Hiding the Search Details pane

Displaying Search Details with Search Results
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To hide the Search Details pane, allowing more of the Workspace to display Search Results, click Hide search details.

 

After creating a search, see Playback a Recording and Working with Search Results.

Related Topics

Additional Attributes

Defining_Custom_Attributes

Exporting Search Results

 

 

Additional Attributes
Add Additional Attributes to your search using the Add Attribute list. Attributes. The following table describes Additional Attributes
that are available for Extreme Query searches.

What's next?
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Attribute Description

Agent

Select this attribute to specify an Agent's name to be considered in
the search. As you type a name, a drop-down list of possible matches
is displayed. Additional names can be specified by using a semi-
colon separated list.

Duration

Select this attribute to specify the length of a call to be considered in
the search. When you select this attribute a value is displayed. When
you click on the value, the Duration Attribute Values dialog is
displayed. Select an operator from the drop-down list. The following
operators are available in the list: Equal to, Greater than, Greater than
or equal to, Less than, and Less than or equal to. After you select an
operator, enter a time in hh:mm:ss, and click OK.

Phone number

Select this attribute to specify a phone number to be considered in
the search. This attribute accepts the first few number of a phone
number as a valid value for a search.

Note: Only one Phone Number can be added to the search. Values
cannot be specified as a semi-colon separated list.

Queue

Select this attribute to specify a Queue name to be considered in the
search. As you type a queue name, a drop-down list of possible
matches is displayed. Additional queue names can be specified by
using a semi-colon separated list.

 

Up to five Custom Attributes, associated with recordings from the Interaction Recorder Database, can be included in the Add
Attribute list for Extreme Query searches. These Custom Attributes are defined in Interaction Recorder Policy Editor in Interaction
Administrator, and then specified in the Interaction Recorder Extreme Query Server configuration program. Follow these steps to
include Custom Attributes in the Add Attribute list.

First, define the Custom Attributes in Interaction Recorder Policy Editor.
1. From Interaction Administrator, under the Interaction Recorder node, select Policy Editor. In the right pane, double-click

Configuration. The Interaction Recorder Policy Editor dialog is displayed.

Defining Custom Attributes
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2. Custom Attributes are set in Step 4: Select Action, when creating an Initiation Policy.

3. Select the set attribute on the recording action, and under Policy description configure the attribute and value.

Next, in the Interaction Recorder Extreme Query Server configuration program, specify up to five of the Custom Attributes, which
were defined in Interaction Recorder Policy Editor, to be included in the Extreme Query search Add Attribute list.
1. From the Extreme Query Server, open a command window and change the directory to the 32-bit installation directory. If you

chose the default directory during installation, the command will be: 
cd “C:\Program Files\Interactive Intelligence\IRExtremeQueryServer”

2. Run the Extreme Query Server configuration utility by running the command:
FastIRQuerySVRCfgU.exe all

3. You will be prompted for individual configuration items. When you are prompted:

Please enter custom attribute 1 name:
The Extreme Query Engine can index up to 5 custom attributes that are associated with recordings in the CIC database. If
the recordings have no custom attributes, or you do not want to track custom attributes, just enter an underscore "_". If you
do want to track a custom attribute, enter the custom attribute name.

Type the Custom Attribute name, and press Enter.
4. You will be prompted to add up to four additional Custom Attribute names. Type the Custom Attribute name, and press Enter.

Or, if you do not want to add additional custom attributes, type an underscore “_” and press Enter.
5. After all the prompts have completed, restart both the Interaction Recorder Extreme Query Engine and the Interaction Recorder

Extreme Query Server services.

Within one minute, the Extreme Query Engine begins loading Interaction Recorder recording information into its cache. When
the data is loaded, Extreme Queries can be run.

Related Topics
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Creating an Extreme Query Search

Exporting Search Results

Playback a Recording

Working with Search Results

 

Playback a Recording
To playback a recorded call, from the Search Results pane, in the list of recordings, double-click on a recorded call.

The Audio Playback window is displayed, and the recording begins to play.

Note  Automatic playback is the default setting when you double-click on a recorded call. This setting is configured in
Interaction Recorder. To change the automatic playback setting, from the Tools menu, select Manage Interaction Recorder
Settings.

  

 

Click Audio to select the audio device for the playback. Pause the mouse over a playback control to display its function.

Use the sliders to control the Volume and Speed of the audio playback.

Audio timing indicators display the current position in the recording and the total time of the recording.

Click the information icon  to view Media Information properties, including Length, Audio format, and compression type.

Details pane

Audio Playback window
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The Details pane is included in the Audio Playback window for your reference. The Details pane includes the following pages.

Media Details

This page displays the details for the recorded call. These details include:
Recording Title
Recording Date
Recording ID
Details of the call

Participant Data

This page displays information on the parties of the recorded call. The page displays Attributes and Values for the call participants.

Custom Attributes

This page displays the defined custom attributes that apply to this recorded call.

Audit Trail

This page displays information on audit events. The information includes: Date/Time, Audit Event, User, and Comments on the
event.

Scoring

Use the Scoring page to assign a published Questionnaire to a recorded call and to Score the call.

Moving the Details pane

You can undock the Details pane from the playback window and move it to another location on your screen. To undock the Details
pane, double-click the title bar. The Details pane moves from the window. To move the Details pane to another place on your
screen, click on the title bar and drag the window.

To dock the Details pane back in the playback window, double-click the title bar. The Details pane docks back in the playback
window.

Hiding the Details pane

There are two ways to Hide the Details pane, Hide and Auto Hide. When you Hide the Details pane, it does not appear in the
playback window. When you Auto Hide the Details pane, a tabbed page is displayed at the bottom of the window. Auto Hide allows
you to display a pop-up pane.

To Hide the Details pane, right-click on the title bar, and on the shortcut menu, click Hide. To display the Details pane again, right-
click in the playback window and on the shortcut menu point to Show and click Details. The Details pane is displayed in the
window.

To Auto Hide the Details pane, right-click on the title bar, and on the shortcut menu, click Auto Hide. A tabbed page is displayed at
the bottom of the window. To display the Details pane again, click the tab, and the Details pane pops up in the window. To turn Auto
Hide off, when the pane is displayed, right-click the title bar and click Auto Hide.

 

Related Topics

Creating an Extreme Query Search

Score a Recording

Working with Search Results
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Score a Recording

Access the Scoring page from the Search Results view in the Workspace.

To access the scoring page:
1. Double-click on a recorded call. The Audio Playback window is displayed, and the recording begins to play.

2. To display the Scoring page, in the Details pane, click the Scoring tab.

Accessing the Scoring page
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Questionnaires that have previously been assigned to a recording are displayed on the Scoring page. Additional Questionnaires can
be assigned to the recording on the Scoring page using the Add Questionnaire button. To assign a questionnaire to a recording,
click Add Questionnaire, and select a questionnaire from the Select Questionnaire dialog.

Only Questionnaires that have been published are available for scoring.  If no questionnaires are available when you click Add
Questionnaire, you need to switch to the Interaction Recorder add-on module to Create and Publish a New Questionnaire.

Notes  

- Non-admin users only see Questionnaire scorecards that they have scored. To allow users to see all scorecards for a
recording, the CIC Administrator can create a Security Policy so a user can view scorecards. This Security Policy can be
applied to Agents or Roles. Questionnaire Directory Admin Access and other security rights will still apply. For non-admin
users, in order to finish a scorecard that has already been scored by another user, the user must first save the scorecard to take
ownership and then the user can finish the scorecard.

- When a scoring user does not have the can view participant contact information security right for a recording, for security
purposes the scored agent’s name is not displayed, and is replaced with asterisks.  Also, in a recording that has multiple
participants, the Select Participant dialog displays participants by number when  the scoring user does not have the can view
participant contact information security right.

To score a recording:
1. On the Scoring page, click Score. The Scorecard is displayed and the media player is launched.

Assigning a Questionnaire

Scoring a recording
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For additional information, from the Scorecard press F1 and the Scoring Dialog Help topic is displayed.

Details of the call are displayed in the Audio Playback window.
2. When you have completed scoring the interaction, click Finish. If the Scorecard has been failed, the Finish button is labeled

Finish (Failed). The scored results are now available for reporting.
3. To save a scored interaction to be e-mailed or to finish scoring later, click Save.

Related Topics

Playback a Recording

Working with Search Results

 

Working with Search Results
When a search is complete, the results are displayed in the Search Results pane. A list of recorded calls is displayed in a grid, which
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gives details of the recording. Use the Search Results pane to review the details of a recording and to playback and score a
recorded call. Also, you can display the search results in graphs, allowing you to analyze data recording results by Queue, Agent per
Queue, and Recordings per Agent.

The results of a search are displayed in the grid in the Workspace. The grid displays a list of recordings, sorted by date, from the
search.

Selecting Fields for the grid

To change the Fields that are displayed in the grid, click the Field Chooser  on the top left of the grid.
In the Field Chooser dialog select the Fields to display in the grid.

Sorting Columns in the grid

To sort a grid column in ascending or descending order, click the Field name.

Refining search results

To further refine the search results, use the Filter Criteria selection fields below each Field. To create a field filter for the search
results displayed in the grid, select the field below the Field name. The field search filter is displayed. To select an operand for the

search, click . In the drop-down list, select the search criteria. Depending on the field and your selections, an additional dialog

might be displayed. The search results are displayed according to your search filter. To clear the filter criteria, in the field click .

To clear all filter criteria, click  at the left on the Filter Criteria selection fields grid row.

Search Results grid
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To display results in a Graph, in the Search Results pane click the Show Graph button. 

The View Graph Data page displays the search results in an Agents Per Queue pie graph. Move the mouse pointer over a slice of the
pie graph to display information on the number of recordings in a queue.

To display a bar graph of Agents and the number of their recordings for a Queue, double-click on a slice of the pie graph. A Bar
Graph is displayed.

 

Displaying Search Results in a graph
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To show information about an Agent's recordings, move the mouse pointer over an Agent's column.

To display the recordings associated with an Agent, double-click the Agent's column. The recordings are displayed in an Agent grid
below the graph.
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To playback a recorded call, from the Agent's search results pane, in the list of recordings, double-click on a recorded call. The
Audio Playback window is displayed, and the recording begins to play.

 

Related Topics

Creating an Extreme Query Search

Exporting Search Results

Score a Recording
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Exporting Search Results
Search Results can be exported to a CSV, Excel, or PDF file. You can export results from a Search Results grid, or from an Agent's
search grid.

To export All of  the results from a search to a file, in the Search Results pane, right-click, and on the shortcut menu point to Export
results and select a file type.

To export Selected rows of search results to a file, in the Search Results pane select the rows to be exported. Right-click, and on
the shortcut menu point to Selected rows and select a file type.

 

Search results can also be exported using Export Results on the File menu. After a search is run, on the File menu, point to Export
Results and make your export selection.

Related Topics

Creating an Extreme Query Search

Working with Search Results

 

Exporting All search results to a file

Exporting selected search results to a file
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Miscellaneous topics

Agent Graph Data View
This page displays the search results for Agents and the number of their recordings for a Queue, in a bar graph. To show
information about an Agent's recordings, move the mouse pointer over an Agent's column.

To display the recordings associated with an Agent, double-click the Agent's column. The recordings are displayed in an Agent
search results pane below the graph.

To playback a recorded call, from the Agent's search results pane, in the list of recordings, double-click on a recorded call. The
Audio Playback window is displayed, and the recording begins to play.

 

 

Audio Playback Dialog
Use this dialog to control the playback of a recorded call. Click the Audio menu to select the audio device for the playback. The
standard playback controls are Play, Stop, Rewind, Fast Forward, Mute, Volume, and Speed. Pause the mouse over a playback
control to display its function. Audio timing indicators display the current position in the recording and the total time of the
recording.

Click the information icon  to view Media Information properties, including Length, Audio format, and compression type.

The Details pane is included in the Audio Playback window for your reference. The Details pane includes the following pages.

Media Details

This page displays the details for the recorded call. These details include:
Recording Title
Recording Date
Recording ID
Details of the call

Participant Data

This page displays information on the parties of the recorded call. The page displays Attributes and Values for the call participants.

Custom Attributes

This page displays the defined custom attributes that apply to this recorded call.

Audit Trail

This page displays information on audit events. The information includes: Date/Time, Audit Event, User, and Comments on the
event.

Scoring

Use the Scoring page to assign a published Questionnaire to a recorded call and to Score the call.

Details pane

Moving the Details pane
22



You can undock the Details pane from the playback window and move it to another location on your screen. To undock the Details
pane, double-click the title bar. The Details pane moves from the window. To move the Details pane to another place on your
screen, click on the title bar and drag the window.

To dock the Details pane back in the playback window, double-click the title bar. The Details pane docks back in the playback
window.

There are two ways to Hide the Details pane, Hide and Auto Hide. When you Hide the Details pane, it does not appear in the
playback window. When you Auto Hide the Details pane, a tabbed page is displayed at the bottom of the window. Auto Hide allows
you to display a pop-up pane.

To Hide the Details pane, right-click on the title bar, and on the shortcut menu, click Hide. To display the Details pane again, right-
click in the playback window and on the shortcut menu point to Show and click Details. The Details pane is displayed in the
window.

To Auto Hide the Details pane, right-click on the title bar, and on the shortcut menu, click Auto Hide. A tabbed page is displayed at
the bottom of the window. To display the Details pane again, click the tab, and the Details pane pops up in the window. To turn Auto
Hide off, when the pane is displayed, right-click the title bar and click Auto Hide.

 

Interaction Recorder Extreme Query View
Use this page to create an Extreme Query search to quickly retrieve and playback a recorded call. Searches can be created using
Attributes or an ID.

Search criteria must contain a Date attribute or a Time attribute, or both. Date and Time are configured separately. When a Date and
Time are both configured, the Time attribute is the time of day a recording might have occurred for each date included in the search.
For example, if the Date is specified as Last Month and the Time is specified between 9:00:00 AM and 5:00:00 PM, the search
results include recordings that occurred between 9 AM and 5 PM on every day of the previous month. If a Date is not specified, the
search results include all of the recordings in the database for the configured Time.

Follow these steps to create a search using Attributes.
1. In the Search by area, select Attributes.
2. Under Date, in the drop-down list, select the Date attribute. Date options are: Date range, Today, Yesterday, Last Week, Last

Month, or No date. If you select Date range, from the next list select an option Before, After, or Between. Depending on your
choice, in the Date boxes type or select a date from the drop-down calendar.

3. Under Time of Day, in the drop-down list, select the Time attribute. Time options are: No Time, After, Before, Between.
Depending on your choice, in the Time boxes type or select the part of the time you want to change.

4. Add additional attributes to your search using the Add Attribute list. Available attributes are: Agent, Duration, Phone number,
and Queue. You will be required to configure additional values based on your attribute choices. For more information, see
Additional Attributes. To delete an attribute from a search, click the attribute button and on the menu, click Remove. 

Note  Up to five additional custom attributes can be defined for the Add Attribute list. Define custom attributes in Interaction
Recorder Policy Editor in Interaction Administrator. For more information, see Defining_Custom_Attributes.

5. When search attributes are complete, click Search. The results are displayed in the Search Results pane.

There are two options for searching with an ID. You can search by Recording ID or by Interaction ID.

Follow these steps to create a search using an ID.
1. In the Search by area, select ID.
2. In the box displayed to the right, select either Recording ID or Interaction ID.

Hiding the Details pane

Creating a search using attributes

Creating a search using an ID
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3. In the ID box, type a valid ID string.
4. Click Search. The recording is displayed in the Search Results pane.

When you run a search, the Search Results pane is displayed in the Workspace. If you want to view the details of the search, click
Show search details.

The Search details pane is displayed at the top of the Workspace.

To hide the Search Details pane, allowing more of the Workspace to display Search Results, click Hide search details.

When a search is complete, the results are displayed in the Search Results pane. A list of recorded calls is displayed in a grid, which
gives details of the recording. Use the Search Results pane to review the details of a recording and to playback a recorded call.
Also, you can display the search results in graphs, allowing you to analyze data recording results by Queue, Agent per Queue, and
Recordings per Agent.

Search Results grid

The results of a search are displayed in the grid in the Workspace. The grid displays a list of recordings, sorted by date, from the
search.

Displaying Search Details with Search Results

Hiding the Search Details pane

Search Results
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Selecting Fields for the grid

To change the Fields that are displayed in the grid, click the Field Chooser  on the top left of the grid.
In the Field Chooser dialog select the Fields to display in the grid.

Sorting Columns in the grid

To sort a grid column in ascending or descending order, click the Field name.

Refining search results

To further refine the search results, use the Filter Criteria selection fields below each Field. To create a field filter for the search
results displayed in the grid, select the field below the Field name. The field search filter is displayed. To select an operand for the

search, click . In the drop-down list, select the search criteria. Depending on the field and your selections, an additional dialog

might be displayed. The search results are displayed according to your search filter. To clear the filter criteria, in the field click .

To clear all filter criteria, click  at the left on the Filter Criteria selection fields grid row.

To display results in a Graph, in the Search Results pane click the Show Graph button 

.
The View Graph Data page is displayed in the Workspace.

Displaying Search Results in a graph
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Menu Bar
Commands and actions are organized in menus that you use to work with Interaction Recorder Extreme Query. Click a menu title on
the menu bar to display a list of choices. To choose one of the commands listed on a menu, click it.

 

Navigation Pane
Use the Interaction Recorder Extreme Query Navigation Pane to begin a search.  From the Interaction Recorder Extreme Query
Navigation Pane, click Search for recordings to open the Extreme Query page in the Workspace.

 

Queue Graph Data View
This page displays the search results for Queues, in a pie graph. The percentages of the number of recordings for each queue, in
this search, are displayed. Move the mouse pointer over a slice of the pie graph to display information on the number of recordings
in a queue.

The total number of recordings for this search is displayed in Total Recordings. The total number of queues for this search is
displayed in Total Queues. The graph legend lists the names of the queues in this search.

To display a bar graph of the Agents and the number of their recordings for a Queue, double-click on a slice of the pie graph. A Bar
Graph of Agent names is displayed, showing the number of recordings for each Agent in the Queue.
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Scoring Dialog
Use this dialog to score a recorded call. The title of the Questionnaire is displayed in the dialog title bar. The question group name
is displayed on a tabbed page in the dialog, and the questions are on the group page.

After reviewing the recorded call, answer the questions. If Help Text is available for a question, it is displayed below the question. If

a comment can be added to a question while scoring, it is indicated by the Add Comments  button. Required questions are
indicated by an asterisk (*).

The Total Score Contribution is displayed at the bottom of the Group page.

Click this toggle button to indicate this Scorecard has passed.

Click this toggle button to indicate this Scorecard has failed. When the Failed button is selected a warning is displayed at the top of
the dialog indicating the Scorecard has been failed, and the Finish button is labeled Finish (Failed).

The Score percentage and Rank are displayed by Group in the right pane of the dialog.

The averaged percentage for scored Questionnaire groups is displayed in the Total Score. The ranking is displayed for the total
score in Rank.

If applicable for the Questionnaire, the averaged percentage for the Non-critical questions is displayed in Non-critical Score.

If applicable for the Questionnaire, the averaged percentage for the critical questions is displayed in Critical Accuracy. The correct
number of responses for the total number of critical questions is also indicated.

Finish

When you have completed scoring the interaction, click Finish. If the Scorecard has been failed, the Finish button is labeled Finish
(Failed). The scored results are now available for reporting.

Save

To save a scored call to be e-mailed or to finish scoring later, click Save.

 

 

Passed

Failed

Scoring Results

Total Score and Rank

Non-critical Score

Critical Accuracy
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Extreme Query Workspace tab
The Interaction Recorder Extreme Query Workspace tab is located to the left of the Navigation Pane. Use this tab to display the
Extreme Query module in the Workspace.

 

Workspace
The Interaction Recorder Extreme Query View is displayed in the Workspace. Use this view to create a search and display Search
Results in the Workspace.
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Change log

Date Changes

12-March-2019 Created this change log.

29


	Table of Contents
	About Interaction Recorder Extreme Query
	Related Topics

	Extreme Query Client User Interface
	Related Topics

	Review Interaction Recorder Extreme Query Resources
	Related Topics

	Extreme Query Searches
	Creating an Extreme Query Search
	Creating a Search
	Creating a Search using Attributes
	Creating a Search using an ID

	Displaying Search Details with Search Results
	Hiding the Search Details pane

	What's next?
	Related Topics


	Additional Attributes
	Defining Custom Attributes
	Related Topics


	Playback a Recording
	Audio Playback window
	Details pane


	Score a Recording
	Accessing the Scoring page
	Assigning a Questionnaire
	Scoring a recording
	Related Topics


	Working with Search Results
	Search Results grid
	Selecting Fields for the grid
	Sorting Columns in the grid
	Refining search results

	Displaying Search Results in a graph
	Related Topics


	Exporting Search Results
	Exporting All search results to a file
	Exporting selected search results to a file
	Related Topics



	Miscellaneous topics
	Agent Graph Data View
	Audio Playback Dialog
	Details pane
	Media Details
	Participant Data
	Custom Attributes
	Audit Trail
	Scoring

	Moving the Details pane
	Hiding the Details pane

	Interaction Recorder Extreme Query View
	Creating a search using attributes
	Creating a search using an ID
	Displaying Search Details with Search Results
	Hiding the Search Details pane
	Search Results
	Search Results grid

	Displaying Search Results in a graph

	Menu Bar
	Navigation Pane
	Queue Graph Data View
	Scoring Dialog
	Passed
	Failed
	Scoring Results
	Total Score and Rank
	Non-critical Score
	Critical Accuracy
	Finish
	Save


	Extreme Query Workspace tab
	Workspace

	Change log

